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Chapter 1 
Overview of SOLIDWORKS® 2018 and the User Interface 

Below are the desired outcomes and usage competencies based on the completion of 
Chapter 1.  

Desired Outcomes: Usage Competencies:  

• A comprehensive 
understanding of the 
SOLIDWORKS® 2018 User 
Interface (UI) and 
CommandManager. 

• Ability to establish a SOLIDWORKS session.   

• Aptitude to utilize the following items: Menu 
bar toolbar, Menu bar menu, Drop-down 
menus, Context toolbars, Consolidated drop-
down toolbars, System feedback icons, 
Confirmation Corner, Heads-up View toolbar, 
Document Properties and more. 

• Open a new and existing SOLIDWORKS part. 

• Knowledge to zoom, rotate and maneuver a 
three button mouse in the SOLIDWORKS 
Graphics window. 
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Notes: 
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Chapter 1 - Overview of SOLIDWORKS® 2018 and the User Interface 

Chapter Objective 

Provide a comprehensive understanding of the SOLIDWORKS® default User Interface 
and CommandManager: Menu bar toolbar, Menu bar menu, Drop-down menu, Right-
click Pop-up menus, Context toolbars/menus, Fly-out tool button, System feedback icons, 
Confirmation Corner, Heads-up View toolbar and more.   

On the completion of this chapter, you will be able to: 

• Utilize the SOLIDWORKS Welcome dialog box. 

• Establish a SOLIDWORKS session. 

• Comprehend the SOLIDWORKS 2018 User Interface. 

• Recognize the default Reference Planes in the FeatureManager. 

• Open a new and existing SOLIDWORKS part. 

• Utilize SOLIDWORKS Help and SOLIDWORKS Tutorials. 

• Zoom, rotate and maneuver a three button mouse in the SOLIDWORKS Graphics 
window. 

What is SOLIDWORKS®? 

• SOLIDWORKS® is a mechanical design automation software package used to build 
parts, assemblies and drawings that takes advantage of the familiar Microsoft® 
Windows graphical user interface. 

• SOLIDWORKS is an easy to learn design and analysis tool (SOLIDWORKS 
Simulation, SOLIDWORKS Motion, SOLIDWORKS Flow Simulation, 
Sustainability, etc.), which makes it possible for designers to quickly sketch 2D and 
3D concepts, create 3D parts and assemblies and detail 2D drawings.  

• Model dimensions in SOLIDWORKS are associative between parts, assemblies and 
drawings. Reference dimensions are one-way associative from the part to the drawing 
or from the part to the assembly.  

• This book is written for the beginner to intermediate user.  
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Start a SOLIDWORKS 2018 Session 
Start a SOLIDWORKS session and familiarize yourself with the SOLIDWORKS User 
Interface. As you read and perform the tasks in this chapter, you will obtain a sense of 
how to use the book and the structure. Actual input commands or required actions in the 
chapter are displayed in bold. 

This book does not cover starting a SOLIDWORKS session in detail for the first time. A 
default SOLIDWORKS installation presents you with several options. For additional 
information, visit http://www.SOLIDWORKS.com. 

Redeem the code on the inside cover of the book. View the provided videos and 
models to enhance the user experience.  

Activity: Start a SOLIDWORKS Session. 

Start a SOLIDWORKS session.  
1) Type SOLIDWORKS in the Search Window.   

2) Click All Programs. 

3) Click the SOLIDWORKS 2018 application (or if 
available, double-click the SOLIDWORKS icon on the 
Desktop). When you open the SOLIDWORKS 
software, view the Welcome dialog box. The Welcome 
dialog box provides a convenient means to open 
documents, view 
folders, access 
SOLIDWORKS 
resources, and stay 
updated on 
SOLIDWORKS news.  

4) View your options. Do 
not open a document at 
this time. 

You can also click 
Welcome to 
SOLIDWORKS  
(Standard toolbar), Help > 
Welcome to 
SOLIDWORKS, or Welcome to SOLIDWORKS on the 
SOLIDWORKS Resources  tab in the 
Task Pane to open the Welcome dialog 
box.  
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Home Tab  
The Home tab lets you open new and 
existing documents, view recent documents 
and folders, and access SOLIDWORKS 
resources.  

Sections in the Home tab include New, 
Recent Documents, Recent Folders, and 
Resources. 

Recent Tab  
The Recent tab lets you view a longer list of 
recent documents and folders. Sections in the 
Recent tab include Documents and Folders.  

The Documents section includes thumbnails 
of documents that you have opened recently. 
Click a thumbnail to open the document, or 
hover over a thumbnail to see the document 
location and access additional information 
about the document. When you hover over a 
thumbnail, the full path and last saved date of 
the document appears. 

Learn Tab  
The Learn tab lets you access instructional 
resources to help you learn more about the 
SOLIDWORKS software.  

Sections in the Learn tab include: 

• Introducing SOLIDWORKS. Opens 
the Introducing SOLIDWORKS book. 

• Tutorials. Opens the step-by-step 
tutorials in the software. 

• MySolidWorks Training. Opens the 
Training section at MySolidWorks.com. 

• Samples. Opens local folders containing 
sample models. 

• 3DContentCentral. Opens 
3DContentCentral.com. 

• Online Tutorials. Opens the SOLIDWORKS Tutorials (videos) section at 
solidworks.com. 

• My Training. Opens the My Training section at MySolidWorks.com. 
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• Certification. Opens the SOLIDWORKS Certification Program section at 
solidworks.com. 

• Curriculum. Opens the Curriculum section at solidworks.com. 

When you install the software, if you do not install the Help Files or Example Files, the 
Tutorials and Samples links are unavailable. 

Alerts Tab 
The Alerts tab keeps you updated with 
SOLIDWORKS news.  
Sections in the Alerts tab include: 

Critical. The Critical section includes 
important messages that used to appear in a 
dialog box. If a critical alert exists, the 
Welcome dialog box opens to the Critical 
section automatically on startup, even if you 
selected Do not show at startup in the dialog 
box. Alerts are displayed until you select Do 
not show this message again. 

The Critical section does not appear if 
there are no critical alerts to display. 

Troubleshooting. The Troubleshooting 
section includes troubleshooting messages 
and recovered documents that used to be on 
the SOLIDWORKS Recovery tab in the Task 
Pane. 

If the software has a technical problem 
and an associated troubleshooting message 
exists, the Welcome dialog box opens to the 
Troubleshooting section automatically on 
startup, even if you selected Do not show at 
startup in the dialog box.  
Technical Alerts. The Technical Alerts 
section opens the contents of the 
SOLIDWORKS Support Bulletins RSS feed 
at solidworks.com. 
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Close the Welcome dialog box.  
5) Click Close  from the Welcome dialog box. The SOLIDWORKS Graphics window is 

displayed. 

 

If you do not see this screen, click the SOLIDWORKS Resources  icon on the right side of 
the Graphics window located in the Task Pane.  
6) Hover the mouse pointer over the SOLIDWORKS icon. 

7) If needed, Pin the Menu Bar toolbar. View your options from the Menu bar menu: File, 
View Tools and Help.  
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Menu Bar toolbar 

The SOLIDWORKS (UI) is designed to 
make maximum use of the Graphics 
window. The Menu Bar toolbar contains a set of the most 
frequently used tool buttons from the Standard toolbar.  

The following default tools are available:  

• New  - Creates a new document; Open  - Opens an existing document; Save  - 
Saves an active document; Print  - Prints an active document; Undo  - Reverses the 
last action; Select  - Selects Sketch entities, components and more; Rebuild  - 
Rebuilds the active part, assembly or drawing; File Properties  - Shows the summary 
information on the active document; and Options  - Changes system options and 
Add-Ins for SOLIDWORKS.  

Menu Bar menu 

Click SOLIDWORKS in the Menu Bar toolbar to 
display the Menu Bar menu. SOLIDWORKS 
provides a context-sensitive menu 
structure. The menu titles remain the 
same for all three types of 
documents, but the menu items 
change depending on which type of document is active.   

Example: The Insert menu includes features in part documents, mates in assembly documents, 
and drawing views in drawing documents. The display of the menu is also dependent on the 
workflow customization that you have selected. The default menu items for an active 
document are File, Edit, View, Insert, Tools, Window, Help and Pin. 

The Pin  option displays the Menu bar toolbar and the Menu bar menu as illustrated. 
Throughout the book, the Menu bar menu and the Menu bar toolbar are referred to as the 
Menu bar.  
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Drop-down menu  
SOLIDWORKS takes advantage of the familiar Microsoft® 
Windows user interface. Communicate with SOLIDWORKS 
through drop-down menus, Context sensitive toolbars, 
Consolidated toolbars or the CommandManager tabs.  

A command is an instruction that informs SOLIDWORKS 
to perform a task.  

To close a SOLIDWORKS drop-down menu, press the Esc key. 
You can also click any other part of the SOLIDWORKS 
Graphics window or click another drop-down menu.  

Create a New Part Document 

In the next section create a new part document.  

Activity: Create a new Part Document. 

A part is a 3D model, which consists of features. What are features?  

• Features are geometry building blocks. 

• Most features either add or remove material. 

• Some features do not affect material (Cosmetic Thread). 

• Features are created either from 2D or 3D sketched profiles or 
from edges and faces of existing geometry.  

• Features are individual shapes that, combined with other 
features, make up a part or assembly. Some features, such as 
bosses and cuts, originate as sketches. Other features, such as 
shells and fillets, modify a feature's geometry.  

• Features are displayed in the FeatureManager as illustrated 
(Boss-Extrude1, Cut-Extrude1, Cut-Extrude2, Mirror1,         
Cut-Extrude3 and CirPattern1).  

The first sketch of a part is called the Base Sketch. The Base 
sketch is the foundation for the 3D model. In this book, we focus on 
2D sketches and 3D features.  
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There are two modes in the New 
SOLIDWORKS Document dialog box: 
Novice and Advanced. The Novice option is 
the default option with three templates. The 
Advanced mode contains access to 
additional templates and tabs that you create 
in system options. Use the Advanced mode 
in this book.  

Create a new part.  
8) Click New  from the Menu bar. The 

New SOLIDWORKS Document dialog 
box is displayed. 

Select the Advanced mode. 
9) Click the Advanced button as 

illustrated. The Advanced mode is set.  

10) Click the Templates tab. 

11) Click Part. Part is the default template 
from the New SOLIDWORKS Document 
dialog box.  

12) Click OK from the New SOLIDWORKS 
Document dialog box. 

Illustrations may vary depending on 
your SOLIDWORKS version and operating system.  

  

The Advanced mode remains selected for all new documents in the current SOLIDWORKS 
session. When you exit SOLIDWORKS, the Advanced mode setting is saved. 

The default SOLIDWORKS installation contains two tabs in the New SOLIDWORKS 
Document dialog box: Templates and Tutorial. The Templates tab corresponds to the default 
SOLIDWORKS templates. The Tutorial tab corresponds to the templates utilized in the 
SOLIDWORKS Tutorials.  

Novice display 

Advanced display 
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Part1 is displayed in the FeatureManager and is the name of the document. Part1 is the default 
part window name.  

The Part Origin  is displayed in blue in the center of the Graphics window. The Origin 
represents the intersection of the three default reference planes: Front Plane, Top Plane and 
Right Plane. The positive X-axis is horizontal and points to the right of the Origin in the Front 
view. The positive Y-axis is vertical and points upward in the Front view. The 
FeatureManager contains a list of features, reference geometry, and settings utilized in the 
part.   

Edit the document units directly from the Graphics window as 
illustrated.  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 Model Mode    3D Views    Motion Mode                                                                                  Units           Tags 

Main Menu Toolbar 

Heads-up View Toolbar 
Task Pane 

Origin 

Default CommandManager 

Default Part FeatureManager 

Hide/Show FeatureManager 

Triad 
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View the Default Sketch Planes. 

13) Click the Front Plane from the FeatureManager. 

14) Click the Top Plane from the FeatureManager. 

15) Click the Right Plane from the FeatureManager. 

16) Click the Origin from the FeatureManager. The Origin is the intersection of the Front, Top 
and Right Planes. 

 

Redeem the code on the inside cover of the book. In the next section, download the    
SW-TUTORIAL-2018 folder to your hard drive. Open the Bracket part. Review the 
features and sketches in the Bracket FeatureManager. Work directly from your hard 
drive.  

Activity: Download the SW-TUTORIAL-2018 folder. Open a Part. 

Download the SW-TUTORIAL-2018 folder. Open an existing SOLIDWORKS part.  
17) Download the SW-TUTORIAL-2018 folder to a local 

hard drive.  

18) Click Open  from the Menu bar menu. 

19) Browse to the SW-TUTORIAL-2018\Bracket folder. 

20) Double-click the Bracket part. The Bracket part is 
displayed in the Graphics window.  
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The FeatureManager design tree is located on the left side of the SOLIDWORKS 
Graphics window. The FeatureManager provides a summarized view of the active part, 
assembly, or drawing document. The tree displays the details on how the part, assembly 
or drawing document was created.  

Use the FeatureManager rollback bar to temporarily roll back to an earlier state, to 
absorbed features, roll forward, roll to previous, or roll to the end of the FeatureManager 
design tree. You can add new features or edit existing features while the model is in the 
rolled-back state. You can save models with the rollback bar placed anywhere.  

In the next section, review the features in the Bracket FeatureManager using the Rollback 
bar.  

Activity: Use the FeatureManager Rollback Bar option. 

Apply the FeatureManager Rollback Bar. Revert to an earlier state in the model. 
21) Place the mouse pointer over the rollback bar in the FeatureManager design tree as 

illustrated. The pointer changes to a hand . Note the 
provided information on the feature. This is called Dynamic 
Reference Visualization.  

22) Drag the rollback bar up the 
FeatureManager design tree until it 
is above the features you want 
rolled back, in this case 10.0 (10) 
Diameter Hole1. 

23) Release the mouse button.  

Part FeatureManager 
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View the first feature in the Bracket Part. 
24) Drag the rollback bar up the FeatureManager above Fillet1. View the results in the 

Graphics window. 

 

Return to the original Bracket Part FeatureManager.  
25) Right-click Extrude-Thin1 in the 

FeatureManager. The Pop-up 
Context toolbar is displayed. 

26) Click Roll to End. View the results 
in the Graphics window.   
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Heads-up View toolbar 

SOLIDWORKS provides the user with 
numerous view options. One of the most useful 
tools is the Heads-up View toolbar displayed in 
the Graphics window when a document is active.   

Dynamic Annotation Views : Only available with SOLIDWORKS MBD (Model 
Based Definition). Provides the ability to control how annotations are displayed when 
you rotate models. 

In the next section, apply the following tools: Zoom to Fit, Zoom to Area, Zoom out, 
Rotate and select various view orientations from the Heads-up View toolbar.  

Activity: Utilize the Heads-up View toolbar. 

Zoom to Fit the model in the Graphics window. 

27) Click the Zoom to Fit  icon. The tool fits the model to 
the Graphics window. 

Zoom to Area on the model in the Graphics window. 

28) Click the Zoom to Area  icon. The Zoom to Area  
icon is displayed. 

Zoom in on the top left hole. 
29) Window-select the top left corner as illustrated. View the 

results.  

De-select the Zoom to Area tool. 

30) Click the Zoom to Area  icon. 

Fit the model to the Graphics window. 
31) Press the f key. 

Rotate the model.  
32) Hold the middle mouse button 

down. Drag upward ,   

downward , to the left  and 

to the right  to rotate the model 
in the Graphics window.  

 

 

 

 

 



Overview of SOLIDWORKS® and the User Interface       SOLIDWORKS® 2018 Tutorial 

 PAGE 1 - 16  

Display a few Standard Views.  
33) Click inside the Graphics window.  

34) Click Front  from the drop-down Heads-
up view toolbar. The model is displayed in 
the Front view. 

35) Click Right  from the drop-down Heads-up 
view toolbar. The model is 
displayed in the Right view. 

36) Click Top  from the drop-down 
Heads-up view toolbar. The model 
is displayed in the Top view. 

Display a Trimetric view of the Bracket 
model.  
37) Click Trimetric  from the drop-

down Heads-up view toolbar as 
illustrated. Note your options. View 
the results in the Graphics window. 

SOLIDWORKS Help 

Help in SOLIDWORKS is context-
sensitive and in HTML format. Help 
is accessed in many ways, including 
Help buttons in all dialog boxes and 
PropertyManager (or press F1) and 
Help  tool on the Standard toolbar 
for SOLIDWORKS Help.  
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38) Click Help from the Menu bar.  

39) Click SOLIDWORKS Help. The SOLIDWORKS Help Home 
Page is displayed by default. View your options. 

SOLIDWORKS Web Help is active by default under Help 
in the Main menu.  

Close Help. Return to the SOLIDWORKS Graphics window.  
40) Close  SOLIDWORKS Home.  

SOLIDWORKS Tutorials 
Display and explore the SOLIDWORKS tutorials. 
41) Click Help from the Menu bar.   

42) Click SOLIDWORKS Tutorials. The SOLIDWORKS Tutorials 
are displayed. The SOLIDWORKS Tutorials are presented by 
category.  

43) Click the Getting Started category. The Getting Started 
category provides lessons on parts, assemblies, and 
drawings. 

In the next section, close all models, tutorials and view the 
additional User Interface tools. 

Activity: Close all Tutorials and Models. 

Close SOLIDWORKS Tutorials and models.  
44) Close  SOLIDWORKS Tutorials. 

45) Click Window, Close All from the Menu bar menu.  

SOLIDWORKS Icon Style  
SOLIDWORKS provides a new icon style. It also allows vector-
based scaling for superior support of high resolution high pixel 
density displays. The icon style standardized the perspective of icons. 
It removes non-essential details, and emphasizes primary elements. 
Consistent visual styling applies to all icons. 

Additional User Interface Tools  
The book utilizes additional areas of the SOLIDWORKS User 
Interface. Explore an overview of these tools in the next section.  
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Right-click  

Right-click in the Graphics window on a model, 
or in the FeatureManager on a feature or sketch 
to display the Context-sensitive toolbar. If you 
are in the middle of a command, this toolbar 
displays a list of options specifically related to 
that command.  

Right-click an empty space in the Graphics window 
of a part or assembly, and a selection context toolbar 
above the shortcut menu is displayed. This provides 
easy access to the most commonly used selection 
tools.  

Consolidated toolbar  
Similar commands are grouped together in the CommandManager. 
For example, variations of the Rectangle sketch tool are grouped in 
a single fly-out button as illustrated.  

If you select the Consolidated toolbar button without expanding: 

For some commands such as Sketch, the most commonly used 
command is performed. This command is the first listed and the 
command shown on the button. 

For commands such as rectangle, where you may want to 
repeatedly create the same variant of the rectangle, the last used 
command is performed. This is the highlighted command when the 
Consolidated toolbar is expanded. 

System feedback icon 

SOLIDWORKS provides system feedback by 
attaching a symbol to the mouse pointer cursor.  

The system feedback symbol indicates what you are 
selecting or what the system is expecting you to 
select.  

As you move the mouse pointer across 
your model, system feedback is 
displayed in the form of a symbol, 
riding next to the cursor as illustrated. 
This is a valuable feature in 
SOLIDWORKS. 

Face Edge     Dimension        Vertex 
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Confirmation Corner 

When numerous SOLIDWORKS commands are active, a symbol or a 
set of symbols is displayed in the upper right hand corner of the 
Graphics window. This area is called the Confirmation Corner.  

When a sketch is active, the confirmation corner box displays two 
symbols. The first symbol is the sketch tool icon. The second symbol 
is a large red X. These two symbols supply a visual reminder that you 
are in an active sketch. Click the sketch symbol icon to exit the sketch 
and to save any changes that you made.  
When other commands are active, the confirmation corner box 
provides a green check mark and a large red X. Use the green check 
mark to execute the current command. Use the large red X to cancel 
the command.  

Confirm changes you make in sketches and tools by using the D 
keyboard shortcut to move the OK and Cancel buttons to the pointer 
location in the Graphics window.  

Heads-up View toolbar  

SOLIDWORKS provides the user 
with numerous view options from 
the Standard Views, View and 
Heads-up View toolbar.  

The Heads-up View toolbar is a 
transparent toolbar that is 
displayed in the Graphics window 
when a document is active.  

You can hide, move or modify the 
Heads-up View toolbar. To modify 
the Heads-up View toolbar, right-
click on a tool and select or 
deselect the tools that you want to 
display.  
The following views are available. Note: available views are document 
dependent.  

• Zoom to Fit : Zooms the model to fit the Graphics window. 

• Zoom to Area : Zooms to the areas you select with a bounding box. 

• Previous View : Displays the previous view. 

For a drawing document 
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• Section View : Displays a cutaway of a part or 
assembly, using one or more cross section planes.  

• Dynamic Annotation Views : Only available 
with SOLIDWORKS MBD. Provides the ability 
to control how annotations are displayed when 
you rotate models. 

The Orientation dialog has an option to display a view cube 
(in-context View Selector) with a live model preview. This helps 
the user to understand how each standard view orientates the 
model. With the view cube, you can access additional standard 
views. The views are easy to understand and they can be accessed 
simply by selecting a face on the cube. 

To activate the Orientation dialog box, press (Ctrl + spacebar) or 
click the View Orientation  icon from the Heads up View 
toolbar. The active model is displayed in the View Selector in an 
Isometric orientation (default view).  

Click the View Selector icon in the Orientation dialog box 
to show or hide the in-context View Selector.  

Press Ctrl + spacebar to activate the View Selector.  

Press the spacebar to activate the Orientation dialog 
box.  

• View Orientation box : Provides the ability to 
select a view orientation or the number of viewports. 
The available options are Top, Left, Front, Right, 
Back, Bottom, Single view, Two view - Horizontal, 
Two view - Vertical, Four view. Click the drop-down 
arrow to access Axonometric views: Isometric, 
Dimetric and Trimetric.    

• Display Style : Provides the ability to display the 
style for the active view. The available options are 
Wireframe, Hidden Lines Visible, Hidden Lines 
Removed, Shaded, Shaded With Edges.  
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• Hide/Show Items : Provides the ability to select items to hide or show in 
the Graphics window. The available items are document dependent. Note the 
View Center of Mass  icon.  

• Edit Appearance : Provides the ability to edit the appearance of entities of 
the model. 

• Apply Scene : Provides the ability to apply a 
scene to an active part or assembly document. View 
the available options.  

• View Setting : Provides the ability to select 
the following settings: RealView Graphics, 
Shadows In Shaded Mode, Ambient Occlusion, 
Perspective and Cartoon.  

• Rotate view : Provides the ability to rotate a 
drawing view. Input Drawing view angle and 
select the ability to update and rotate center marks 
with view.  

• 3D Drawing View : Provides the ability to 
dynamically manipulate the drawing view in 3D 
to make a selection.  

To display a grid for a part, click Options , 
Document Properties tab. Click Grid/Snaps, check 
the Display grid box. 

Add a custom view to the Heads-up View 
toolbar. Press the space key. The Orientation dialog 
box is displayed. Click the New View  tool. The 
Name View dialog box is displayed. Enter a new 
named view. Click OK.  

Use commands to display information about 
the triad or to change the position and orientation 
of the triad. Available commands depend on the 
triad's context. 

 
 

Triad 
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SOLIDWORKS CommandManager 

The SOLIDWORKS CommandManager is a Context-sensitive 
toolbar that automatically updates based on the toolbar you want 
to access. By default, it has toolbars embedded in it based on 
your active document type. When you click a tab below the 
CommandManager, it updates to display that toolbar. For 
example, if you click the Sketch tab, the Sketch toolbar is 
displayed.  

For commercial users, SOLIDWORKS Model Based 
Definition (MBD) is a separate application. For education users, SOLIDWORKS MBD is 
included in the SOLIDWORKS Education Edition as an Add In. 

Below is an illustrated CommandManager for a default Part document.  

 

Button sizes. You can set sizes for buttons from the Toolbars 
tab of the Customize dialog box. To facilitate element selection 
on touch interfaces such as tablets, you can set up the larger Size 
buttons and text from the Options menu (Standard toolbar).  
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The SOLIDWORKS CommandManager is a Context-sensitive 
toolbar that automatically updates based on the toolbar you want 
to access. By default, it has toolbars embedded in it based on 
your active document type.  

For commercial users, SOLIDWORKS Model Based 
Definition (MBD) is a separate application. For education users, 
SOLIDWORKS MBD is included in the SOLIDWORKS Education 
Edition as an Add In. 

Below is an illustrated CommandManager for a default Drawing 
document. 

To add a custom tab to your CommandManager, right-
click on a tab and click Customize CommandManager from 
the drop-down menu. The Customize dialog box is displayed. 
You can also select to add a blank tab as illustrated and 
populate it with custom tools from the Customize dialog box.  
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The SOLIDWORKS CommandManager is a Context-sensitive 
toolbar that automatically updates based on the toolbar you want 
to access. By default, it has toolbars embedded in it based on 
your active document type.  

For commercial users, SOLIDWORKS Model Based 
Definition (MBD) is a separate application. For education users, 
SOLIDWORKS MBD is included in the SOLIDWORKS Education 
Edition as an Add In. 

Below is an illustrated CommandManager for a default 
Assembly document.  

 

By default, the illustrated options are selected in the Customize 
box for the CommandManager. Right-click on an existing tab 
and click Customize CommandManager to view your options.  

You can set the number of mouse gestures to 2, 3, 4, 6, 8, 
or 12 gestures. If you set the number to 2 gestures, you can 
orient them vertically or horizontally. 



SOLIDWORKS® 2018 Tutorial    Overview of SOLIDWORKS® and the User Interface 
 

 PAGE 1 - 25   

Float the CommandManager. Drag the Features, Sketch or any 
CommandManager tab. Drag the CommandManager anywhere 
on or outside the SOLIDWORKS window.   

To dock the CommandManager, perform one of the following:  

While dragging the CommandManager in the SOLIDWORKS 
window, move the pointer over a docking icon - 

, ,  and click the needed 
command. 

Double-click the floating CommandManager to revert the 
CommandManager to the last docking position.  
Screen shots in the book were made using SOLIDWORKS 2018 
SP0 running Windows® 10.  

An updated color scheme for certain icons makes the 
SOLIDWORKS application more accessible to people with 
color blindness. Icons in the active PropertyManager use blue to 
indicate what you must select on the screen: faces, edges, and so 
on. 

Selection Enhancements  

Right-click an empty space in the Graphics window of a part or 
assembly; a selection context toolbar above the shortcut menu 
provides easy access to the most commonly used selection tools. 
• Box Selection . Provides the ability to select entities in 

parts, assemblies, and drawings by dragging a selection box 
with the pointer. 

• Lasso Selection . Provides the ability to select entities by 
drawing a lasso around the entities. 

• Selection Filters . Displays a list of selection filter 
commands. 

• Previous Selection . Displays the previous selection.  

• Select Other . Displays the Select Other dialog box. 

• Select . Displays a list of selection commands. 

• Magnified Selection . Displays the magnifying glass, 
which gives you a magnified view of a section of a model. 
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Save space in the CommandManager; right-click in the 
CommandManager and un-check the Use Large Buttons with 
Text box. This eliminates the text associated with the tool.  

DimXpert provides the ability to graphically check if the 
model is fully dimensioned and toleranced. DimXpert 
automatically recognizes manufacturing features. Manufacturing 
features are not SOLIDWORKS features. Manufacturing 
features are defined in 1.1.12 of the ASME Y14.5M-1994 
Dimensioning and Tolerancing standard. See SOLIDWORKS 
Help for additional information.  

FeatureManager Design Tree  

The FeatureManager consists of five default 
tabs:  

• FeatureManager design tree  tab. 

• PropertyManager  tab. 

• ConfigurationManager  tab.  

• DimXpertManager  tab. 

• DisplayManager  tab. 
Select the Hide FeatureManager Tree Area 

arrows  as illustrated to enlarge the Graphics 
window for modeling. 

The Sensors tool  located in the 
FeatureManager monitors selected 
properties in a part or assembly and 
alerts you when values deviate from the 
specified limits. There are five sensor 
types: Simulation Data, Mass properties, 
Dimensions, Measurement and Costing 
Data.  
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Various commands provide the ability to 
control what is displayed in the 
FeatureManager design tree:  

1. Show or Hide FeatureManager items.  

Click Options  from the Menu 
bar. Click FeatureManager from the 
System Options tab. Customize your 
FeatureManager from the Hide/Show Tree 
Items dialog box.  

2. Filter the FeatureManager design tree. 
Enter information in the filter field. You 
can filter by Type of features, Feature 
names, Sketches, Folders, Mates, User-
defined tags and Custom properties.  

Tags are keywords you can add to a SOLIDWORKS 
document to make them easier to filter and to search. The Tags 

 icon is located in the bottom right corner of the Graphics 
window. 

Collapse all items in the FeatureManager, right-click and 
select Collapse items, or press the Shift + C keys.  

The FeatureManager design tree and the Graphics window are 
dynamically linked. Select sketches, features, drawing views, 
and construction geometry in either pane.  

Split the FeatureManager design tree and either display 
two FeatureManager instances, or combine the 
FeatureManager design tree with the 
ConfigurationManager or PropertyManager.  

Move between the FeatureManager design tree, 
PropertyManager, ConfigurationManager and 
DimXpertManager by selecting the tabs at the top of the 
menu.  

 
 

Split line 
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The ConfigurationManager is located to the right of the 
FeatureManager. Use the ConfigurationManager to create, 
select and view multiple configurations of parts and 
assemblies.  

The icons in the ConfigurationManager denote whether the 
configuration was created manually or with a design table.  

The DimXpertManager tab provides the ability to insert 
dimensions and tolerances manually or automatically. The 
DimXpertManager provides the following selections: Auto 

Dimension Scheme , Basic Location Dimension , 
Basic Size Dimension  Show Tolerance Status , Copy 
Scheme  and TolAnalyst Study .  

Fly-out FeatureManager  
The fly-out FeatureManager design tree provides the 
ability to view and select items in the 
PropertyManager and the FeatureManager design 
tree at the same time.   

Throughout the book, you will select commands and 
command options from the drop-down menu, fly-out 
FeatureManager, Context toolbar or from a 
SOLIDWORKS toolbar.  

Another method for accessing a command is to 
use the accelerator key. Accelerator keys are special 
key strokes, which activate the drop-down menu 
options. Some commands in the menu bar and items 
in the drop-down menus have an underlined 
character.  

Pressing the Alt or Ctrl key followed by the 
corresponding key to the underlined character 
activates that command or option.  

Illustrations may vary depending on your 
SOLIDWORKS version and operating system. 
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Task Pane  
The Task Pane is displayed when a SOLIDWORKS session starts. You can show, 
hide, and reorder tabs in the Task Pane. You can also set a tab as the default so it 
appears when you open the Task Pane, pin or unpin to the default location. 

The Task Pane contains the following default tabs:  

• SOLIDWORKS Resources . 

• Design Library . 

• File Explorer . 

• View Palette . 

• Appearances, Scenes and Decals . 

• Custom Properties . 

• SOLIDWORKS Forum . 

Additional tabs are displayed with Add-Ins. 
Use the Back and Forward buttons in the Design Library 
tab and the Appearances, Scenes, and Decals tab of the Task 
Pane to navigate in folders. 

SOLIDWORKS Resources 

The basic SOLIDWORKS Resources  menu displays the 
following default selections:  

• Welcome to SOLIDWORKS. 

• SOLIDWORKS Tools. 

• Online Resources. 

• Subscription Services. 

Other user interfaces are available during the initial software 
installation selection: Machine Design, Mold Design, 
Consumer Products Design, etc.  
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Design Library 

The Design Library  contains reusable parts, assemblies, and 
other elements including library features.  

The Design Library tab contains four default selections. Each 
default selection contains additional sub categories.  

The default selections are:  

• Design Library. 

• Toolbox.  

• 3D ContentCentral (Internet access 
required). 

• SOLIDWORKS Content (Internet access 
required).  

Activate the SOLIDWORKS Toolbox. 
Click Tools, Add-Ins.., from the Main menu. 
Check the SOLIDWORKS Toolbox Library and 
SOLIDWORKS Toolbox Utilities box from the 
Add-ins dialog box or click SOLIDWORKS 
Toolbox from the SOLIDWORKS Add-Ins tab.  

To access the Design Library folders in a non-
network environment, click Add File Location 

 and browse to the needed path. Paths may 
vary depending on your SOLIDWORKS 
version and window setup. In a network 
environment, contact your IT department for 
system details.  

File Explorer 

File Explorer  duplicates Windows Explorer 
from your local computer and displays: 

• Recent Documents.  

• Samples. 

• Open in SOLIDWORKS 

• Desktop.   
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Search 

The SOLIDWORKS Search box is displayed in the upper right corner 
of the SOLIDWORKS Graphics window (Menu Bar toolbar). Enter 
the text or key words to search. 

New search modes have been added to SOLIDWORKS Search as 
illustrated. 

View Palette 

The View Palette  tool located in the Task Pane 
provides the ability to insert drawing views of an active 
document, or click the Browse button to locate the 
desired document.  

Click and drag the view from the View Palette into an 
active drawing sheet to create a drawing view. 

The selected model is FLATBAR DesignTables in 
the illustration.  
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Appearances, Scenes, and Decals 

Appearances, Scenes and Decals  provide a simplified 
way to display models in a photo-realistic setting using a 
library of Appearances, Scenes, and Decals.  

An appearance defines the visual properties of a model, 
including color and texture. Appearances do not affect 
physical properties, which are defined by materials. 

Scenes provide a visual backdrop behind a model. In 
SOLIDWORKS they provide reflections on the model. 
PhotoView 360 is an Add-in. Drag and drop a selected 
appearance, scene or decal on a feature, surface, part or 
assembly.  

Custom Properties 

The Custom Properties  tool provides the ability to 
enter custom and configuration specific properties directly 
into SOLIDWORKS files.  

SOLIDWORKS Forum 

Click the SOLIDWORKS Forum  icon to search 
directly within the Task Pane. An internet connection is 
required. You are required to register and to log in for 
postings and discussions.  

User Interface for Scaling High 
Resolution Screens 

The SOLIDWORKS software supports high-
resolution, high-pixel density displays. All aspects of 
the user interface respond to the Microsoft Windows® 
display scaling setting. In dialog boxes, 
PropertyManagers, and the FeatureManager design 
tree, the SOLIDWORKS software uses your display 
scaling setting to display buttons and icons at an 
appropriate size. Icons that are associated with text are 
scaled to a size appropriate for the text. In addition, for 
toolbars, you can display Small, Medium, or Large 
buttons. Click the Options drop-down arrow from the 
Standard Menu bar, and click Button size to size the 
icons. 
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Motion Study tab 

Motion Studies are graphical simulations of motion for an assembly. Access the 
MotionManager from the Motion Study tab. The Motion Study tab is located in the bottom 
left corner of the Graphics window.  

Incorporate visual properties such as lighting and camera perspective. Click the Motion Study 
tab to view the MotionManager. Click the Model tab to return to the FeatureManager design 
tree.  

The MotionManager displays a timeline-based interface and provides the following selections 
from the drop-down menu as illustrated: 

• Animation: Apply Animation to animate the motion of an assembly. Add a motor and 
insert positions of assembly components at various times using set key points. Use the 
Animation option to create animations for motion that do not 
require accounting for mass or gravity. 

• Basic Motion: Apply Basic Motion for approximating the 
effects of motors, springs, collisions and gravity on 
assemblies. Basic Motion takes mass into account in 
calculating motion. Basic Motion computation is relatively 
fast, so you can use this for creating presentation animations 
using physics-based simulations. Use the Basic Motion option 
to create simulations of motion that account for mass, 
collisions or gravity.  

If the Motion Study tab is not displayed in the Graphics 
window, click View  Toolbars  MotionManager from the 
Menu bar.  
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3D Views tab 

SOLIDWORKS MBD (Model Based Definition) lets you 
create models without the need for drawings giving you an 
integrated manufacturing solution. MBD helps companies 
define, organize, and publish 3D product and manufacturing 
information (PMI), including 3D model data in industry 
standard file formats.  
Create 3D drawing views of your parts and assemblies that 
contain the model settings needed for review and 
manufacturing. This lets users navigate back to those settings as 
they evaluate the design. 

Use the tools in the SOLIDWORKS MBD CommandManager 
to set up your model with selected configurations, including 
explodes and abbreviated views, annotations, display states, 
zoom level, view orientation and section views. Capture those 
settings so that you and other users can return to them at any 
time using the 3D view palette. 

To access the 3D View palette, click the 3D Views tab at the 
bottom of the SOLIDWORKS window or the SOLIDWORKS 
MBD tab in the CommandManager. The Capture 3D View 
button opens the Capture 3D View PropertyManager, where 
you specify the 3D view name, and the configuration, display 
state and annotation view to capture. See SOLIDWORKS help 
for additional information. 

Dynamic Reference Visualization 
(Parent/Child)  

Dynamic Reference Visualization provides the ability to 
view the parent/child relationships between items in the 
FeatureManager design tree. When you hover over a 
feature with references in the FeatureManager design 
tree, arrows display showing the relationships. If a 
reference cannot be shown because a feature is not 
expanded, the arrow points to the feature that contains 
the reference and the actual reference appears in a text 
box to the right of the arrow.  
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Use Dynamic reference visualization for a part, assembly 
and ever mates.  

To display the Dynamic Reference Visualization, click 
View  User Interface  Dynamic Reference 
Visualization from the Main menu bar.  

Mouse Movements 

A mouse typically has two buttons: a primary button 
(usually the left button) and a secondary button (usually the 
right button). Most mice also include a 
scroll wheel between the buttons to 
help you scroll through documents and 
to Zoom in, Zoom out and rotate 
models in SOLIDWORKS. It is highly 
recommended that you use a mouse 
with at least a Primary, Scroll and 
Secondary button.  

Single-click 

To click an item, point to the item on the screen, and then press and release the primary button 
(usually the left button). Clicking is most often used to select (mark) an item or open a menu. 
This is sometimes called single-clicking or left-clicking. 

Double-click 

To double-click an item, point to the item on the screen, and then click twice quickly. If the 
two clicks are spaced too far apart, they might be interpreted as two individual clicks rather 
than as one double-click. Double-clicking is most often used to open items on your desktop. 
For example, you can start a program or open a folder by double-clicking its icon on the 
desktop. 

Right-click 

To right-click an item, point to the item on the screen, and then press and release the 
secondary button (usually the right button). Right-clicking an item usually displays a list of 
things you can do with the item. Right-click in the open Graphics window or on a command in 
SOLIDWORKS, and additional pop-up context is displayed.  

Scroll wheel 

Use the scroll wheel to zoom-in or to zoom-out of the Graphics window in SOLIDWORKS. 
To zoom-in, roll the wheel backward (toward you). To zoom-out, roll the wheel forward 
(away from you). 
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Summary 

The SOLIDWORKS 2018 User Interface and CommandManager consist of the following 
main options: Menu bar toolbar, Menu bar menu, Drop-down menus, Context toolbars, 
Consolidated fly-out menus, System feedback icons, Confirmation Corner and Heads-up 
View toolbar. 

The default CommandManager Part tabs control the display of the Features, Sketch, 
Evaluate, DimXpert and SOLIDWORKS Add-Ins toolbars.    

The FeatureManager consists of five default tabs:  

• FeatureManager design tree. 

• PropertyManager. 

• ConfigurationManager. 

• DimXpertManager. 

• DisplayManager.  
You learned about creating a new SOLIDWORKS part and opening an existing 
SOLIDWORKS part along with using the Rollback bar to view the sketches and features.  

You also learned about SOLIDWORKS Help, SOLIDWORKS Tutorials and basic 
mouse movements to manipulate your SOLIDWORKS model. 

Opening a SOLIDWORKS document from an earlier 
release can take extra time. After you open and save a file, 
subsequent opening time returns to normal. Use the 
SOLIDWORKS Task Scheduler (SOLIDWORKS 
Professional) to convert multiple files from an earlier 
version to the SOLIDWORKS 2018 format. Click Windows 
Start  All Apps  SOLIDWORKS 2018  
SOLIDWORKS Tools 2018  SOLIDWORKS Task 
Scheduler.  

Templates are part, drawing and assembly documents which 
include user-defined parameters. Open a new part, drawing 
or assembly. Select a template for the new document.  
• Parts. The Parts default template is located in the 

C:\ProgramData\SolidWorks\\SOLIDWORKS 
2018\templates\Part.prtdot folder. 

• Assemblies. The Assemblies default template is located 
in the C:\ProgramData\SolidWorks\\SOLIDWORKS 
2018\templates\Assembly.asmdot folder. 



SOLIDWORKS® 2018 Tutorial    Overview of SOLIDWORKS® and the User Interface 
 

 PAGE 1 - 37   

• Drawings. The Drawings default template is located in the 
C:\ProgramData\SolidWorks\\SOLIDWORKS 2018\templates\Drawing.drwdot 
folder. 

If you modify a document property from an Overall drafting 
standard, a modify message is displayed as illustrated.  

For commercial users, SOLIDWORKS Model Based Definition 
(MBD) is a separate application. For education users, 
SOLIDWORKS MBD is included in the SOLIDWORKS 
Education Edition as an Add In. 

Redeem your code on the inside face of the book. View the 
provided videos and models to enhance the user experience. 

In Chapter 2, obtain the working familiarity of the following 
SOLIDWORKS sketch and feature tools: Line, 
Circle, Centerpoint Straight Slot, Smart Dimension, 
Extruded Boss/Base, Extruded Cut and Linear 
Pattern.   

Create three individual parts: AXLE, SHAFT-
COLLAR and FLATBAR.  

Create the assembly, LINKAGE using the three 
created parts and the downloaded sub-assembly - 
AirCylinder. 
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Notes:  

 




